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AGENDA 
 


 


Day 1 – GPS Data Collection and Integration with GIS 


Lab 8:00-9:00 Class Overview and Introductions 


Lab 9:00-9:30 GPS Settings  


 
9:30-10:00  Travel and Break 


Field 10:00-12:00 GPS Overview and Field Data Collection  


 
12:00-1:00  Lunch 


Lab 1:00-1:30 Exercise 1 – Downloading GPS Data  


Lab 1:30-3:30 Exercise 2  – Using ArcGIS 10 to View and Manage GPS Data


 
3:30-3:45  Break 


Lab 3:45-4:30 Exercise 3 – Mission Planning (Video) 
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AGENDA 
 


 


Day 2  - Spatial Reference, Sampling Design & Data Collection 


Lab 8:00-8:30 Review 


Lab 8:30-9:30 Datums, Map Projections and Coordinate Systems 


 
9:30-9:45  Break 


Lab 9:45-10:45 Exercise 4 – Working with UTM Coordinates  


Lab 10:45-12:00 Exercise 5 – Sampling Design and Uploading Data  


 
12:00-1:00 Lunch 


Field 1:00-3:30 Field Work:  Line and Polygon Data Collection  


 
3:30-4:00  Travel and Break 


Lab 4:00-4:30 Downloading and Viewing Line and Polygon Data  
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AGENDA 
 


 


Day 3 – GPS Field Projects 


Lab 8:00-8:30 Review 


Field 8:30-10:30 Exercise 6 - Mapping Park Infrastructure (Team Project) 


 
10:30-11:00  Break 


Lab 11:00-12:00 Exercise 6 – Data download and GIS work  


 
12:00-1:00  Lunch 


Lab 1:00-2:00 Exercise 6 - continued  


 
2:30-2:45  Break 


Lab 2:00-2:15 Final Project Overview 


Lab/Field 2:15-4:30 Work on Final Projects (Open Break) 
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AGENDA 
 


 


Day 4 – Final Project and Presentations 


Lab/Field 8:00-11:00 Final Projects (Open Break) 


Lab 11:00-12:00 Final Project Presentations  


Lab 12:00-12:15 Course Wrap-up 
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Exercise 1 – Downloading GPS Data Using DNRGPS 
 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 
 
 Customize DNRGPS settings 
 
 Download waypoints (e.g., points) and tracks (e.g., lines or polygons) using 


DNRGPS  
 
 Save GPS field data in ArcGIS shapefile (.shp) file formats 
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Materials created by:  Eric Kelchlin (July 2007) 


Revision: October 2012 


Directory Path:  CSP7101\GPS_Data 


Software: ArcGIS 10, SP5 


Garmin USB Driver  http://www8.garmin.com/support/download_details.jsp?id=591  


DNRGPS v6.15  http://www.dnr.state.mn.us/mis/gis/DNRGPS/DNRGPS.html  


Garmin Web Updater  http://www8.garmin.com/products/webupdater/howtoinstall.jsp  
 
(This software updates the OS and firmware on your GPS unit.  It’s not needed for this 
exercise, but very necessary to keep current with updates.) 
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SECTION 1 – Changing the Default Settings in DNRGPS 
 
This exercise uses DNRGPS, a free tool that allows you to import waypoints and tracks 
from any Garmin device.  DNRGPS allows you to save your data in many different 
spatial file types.  However, as of October 2012, shapefiles (.shp) is the only file type 
that works.  It’s a new tool with lots of supporting code writers, so expect enhances in 
the future.  Google DNRGPS for the latest download or look in the Utilities folder on the 
class DVD. 


 
 
1. Launch the DNRGPS utility from your desktop.   


 
2. Select File > Set Projections > Projection tab.  Change the projection settings 


as illustrated below. 
 
  


 
 
 
 
 


Second, change this field 
to YOUR appropriate 
Projection.  Which is what?  
 
____________________ 


Wait!  Stay on this screen 
before clicking OK. 


First, change this field to 
YOUR appropriate 
Datum.  Which is what?  
 
___________________
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3. Click on the Waypoint Tab.  Uncheck all the fields after comment, except for 
symbol, altitude and model.   
 


 
 


 
4. Click on the Tracks Tab.  Uncheck all fields after new_seg except for altitude 


and model.  Click OK when finished.  Once you set these properties, they will 
be used as the default settings for all future downloads.  However, you can 
modify what fields you want before or during any download session and the 
changes will be immediate. 
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SECTION 2 – Downloading Waypoints and Tracks (lines or polygons) 
 


1. Attach your GPS unit to the computer using the USB cable.  Be careful with the 
earflap on the back of the GPS unit….it will come off!   
 


2. Turn on the GPS unit and select GPS > Find GPS.  The model of the GPS unit 
will be shown just below the main menu after a few seconds indicating the 
connection has been made.  
 
If the GPS unit has not been found, then install the Garmin Driver by selecting 
GPS > Garmin > Install Garmin USB Drivers.  You will need administrative 
rights to install this software. 
 


 
 


3. Download the waypoints and tracks (e.g., lines and polygons) at one fell swoop 
by selecting GPS > Download All.  You can do waypoints and tracks 
individually under each respective button, but this method is quicker. 
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4. Select the Waypoints tab just above the table to view all your waypoints.  To 
save the waypoints as a shapefile, simply select File > Save To > File.   
 
 Browse to the CSP7101\GPS_Data folder and save the waypoints as 


Day1_Points.  Make sure the file type is an ESRI Shapefile (.shp) and click 
the SAVE button. 


 


 
 


5. To save the lines or polygons, simply click on the Tracks tab just above the 
table to view your tracks and select File > Save To > File.   
 
 Browse to the CSP7101\GPS_Data folder and name the tracks 


Day1_Lines or Day1_Polygons.  Choose what data type you want, and 
click OK, twice. 
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Why Do I Have Duplicate Layers On My Map? 
 


Garmin stores all line and polygon data as tracks in the Active Track Log.  When you 
save polygons using the Area Calculation Page or save lines using the Tracks Page 
then you will have duplicate layers when you download the data.  
 
1. To avoid duplicate layers, only select the manually saved records OR the 


automatically saved records from the data table in DNRGPS, then save the 
selected records to file.  Track segments are identified by the gray record 


 
2. After you download the data to your PC, always Clear the Active Track Log and 


delete all saved tracks before you collect any new line or polygon data in the 
field. 


 
 


 
 
 
 
 
 
 


 


Manually saved records 
will be identified by a 
date (or unique name) in 
the tident field. 


Automatically saved 
records will be identified 
as “ACTIVE LOG” in the 
tident field. 
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 Why Are My Tracks Generalized? 
 


1. When you have more than 2% of your Active Track Log memory used up, your 
Garmin unit will automatically begin generalizing the data (i.e., removing 
vertices) of your manually saved tracks to maximize storage space on the 
internal flash drive.  This is carryover tactic from older GPS models that had 
very limited memory (<24 MB).   


 
2. To stop Garmin from generalizing your data make sure your track settings are 


set as shown below.  A logging rate of 2-3 seconds is recommended to avoid 
data simplification issues. 
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Exercise 2 – Using ArcGIS 10 to View and Manage GPS Data 
 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 
 
 Add data to the Table of Contents and change symbology 


 
 Navigate (zoom and pan) in the data view 


 
 View, modify and summarize tabular data in ArcMap 


 
 View layers in ArcCatalog 


 
 Create metadata in ArcCatalog 
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Materials created by:  Eric Kelchlin (July 2011) 


Revision: November 2013 


Software: ArcGIS 10, SP5 


Directory Path:   CSP7101\GPS_Data  


   CSP7101\Exercise2 


Imagery: ArcGIS Online Imagery (Bing) 


Data: Waypoints created by the student, metadata.docx 
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SECTION 1 - Create a New Map Document (MXD) 
 


1. Launch ArcMap  from the desktop. 
 
2. Click the Cancel button on the ArcMap Getting Started Dialog.  This is the quick 


way to start with a new blank map. 
 


3. Let’s add our GPS data and some imagery to our new map.  There are two ways 
to add data.  The first way is to drag-n-drop from ArcCatalog, which is docked to 
the right-side of your screen.   
 


 Scroll your arrow over the docked Catalog button and click on the 


Connect To Folder  button.  We first need to tell where ArcCatalog 
should look for our GPS data, before we can add it to our map. 
 


 Browse to the location of the CSP7101 folder and click OK.  You should 
now have a connection to this folder.  


 
 Open ArcCatalog again, browse down to the GPS_Data folder.  Select the 


shapefile and drag-n-drop onto the blank map.  For multiple shapefiles, 
you will need to drop-n-drop one at a time; no Ctrl or Shift keys for 
grouping. 
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 Add online imagery next by clicking the Add Data  button and 


selecting Add Basemap.  Select Bing Maps Aerial and click .  
Double-clicking on the image works just as well and even saves you time. 


 


 


4. Zoom into the area of interest by clicking the Zoom In  Tool on the Tools 
Toolbar and dragging a box around you’re data.  Alternatively, you can right-click 


on your layer in the Table of Contents and choose Zoom to Layer   to get a 
good view of your field data. 
 


5. Let’s change the symbology of the layers to something easier to see.  Single click 
on the symbol under your point layer.  The Symbol Selector dialog will appear.  
Select the Circle 2 symbol and change the size to 15.  Click OK. 
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6. To label each point, simply right-click on the point layer in the Table of Contents 
(TOC) and select Label Features.   
 


 Right-click on the Day1_Point layer and select Properties.  Select the 
Labels Tab.  Change the Label Field to Ident, beef-up the font to a 10 
and change the color to yellow.  Click OK. 


 


 
 
7. Change the symbology of the line/polygon layers you added to the map to make 


them more visible. 
 


8. Click the Save  button to save your new map document in the CSP7101 
folder.  Name it Day1. 
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SECTION 2 – View, Modify and Summarize Tabular Data 
 
This section introduces you to the most commonly used features when working with 
tabular data. 


 
1. Right-click on your Day1_Point layer and select Open Attribute Table. 


 
2. Expand the table to view all the columns (known as fields in Arc speak).  You can 


sort any field by simply double-clicking on the field header. 
 


3. Let’s say you didn’t like the labels and you wanted to change the values in the 
ident field.  First you need to start an editing session; to do so just select the 
drop-down arrow on the Editor Toolbar and select Start Editing. 
 


 
 


4. Next, simply click on the value you want the change and edit it.  For example, 
say you want to remove all the zeros in the labels. 
 


 When you’re done editing the values, select the drop-down arrow on the 
Editor Tool again and simply select Stop Editing and click Yes to save 
your edits. 
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5. Let’s delete some fields and clean-up the dataset.  To delete an entire field make 
sure you are NOT in edit mode (I know, it’s counter intuitive).   Right-click on the 
header of the field you want to delete and select Delete Field.   
 


 Delete the Type, Latitude, Longitude, y-proj and x-proj fields.  The only 
fields you can NOT delete in this table are FID (feature identity) and 
Shape.  This latter field contains the geometry information for ArcMap, 
delete it and the spatial data are toast! 
 


 
 


6. To add a new field select the Table Options  button and choose Add Field.   
Let’s make this a Text field.  Name it Site_ID and make it 20 characters in 
length.  Click OK when done. 
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7. Let’s fill-in the new field with using a method much quicker than typing text in 
each cell.  Right-click on the Site_ID field header and select Field Calculator.  
Type “Riverside Park” in the location as shown below (with the “ ” marks on the 
ends) and select OK. 
 


 
 


8. Summarizing data in the table is quick and easy as well.  Let’s say that Altitude 
is important to you and all you need is the mean value.  Simply right-click on the 
header of the Altitude field and select Statistics.   
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9. Close the attribute table by clicking the  in the top right corner of the table. 
 


10. Save  your map document again and close ArcMap. 
 
 


SECTION 3 – Creating Metadata in ArcCatalog 10 
 
In this section, you will utilize the metadata editor in ArcCatalog 10 to generate “quick 
and dirty” metadata for your GPS layer.  Not all the mandatory fields are populated, only 
the bare minimum.  It’s possible and recommended to paste text from reports into text 
fields.  A GPS project summary report would be perfect fodder for metadata! 
 


1. Launch ArcCatalog  from the desktop.  
 


2. From the Customize menu, select ArcCatalog Options.   
 


3. Click the Metadata tab and change the metadata style is FGDC CSDGM 
Metadata.   Also make sure that the metadata updates box is checked as shown 
below.  Click OK. 


 


 
 
 


4. In the catalog tree on the left hand side of the screen, navigate to the GPS_Data 
folder and find the layer of interest, which is Day1_Points in this example. 
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5. To start editing metadata, simply highlight the Day 1_Points layer, select the 


Description tab and select the Edit tool  in the Items Description window.   
See the example on the next page.  
 


 
 


 
6. Open the Metadata Word document in the Exercise2 folder.  Copy the blue text 


items and paste in the appropriate sections. 
 
Click Item Descriptions in the Overview section and add the following items: 


 
Tags – add subject keywords separated by commas. 
 
USFWS, Riverside Park, Vero Beach, GPS, Garmin Map76CSx 
 
Summary – add a brief summary of the data. 
 
GPS field data collected as part of the GPS I class (CSP7101) in February 
2012.   Data were collected via a Garmin Map76CSx.  Averaging was 
enabled for most points (10 seconds/point).  WAAS was enabled to 
improve accuracy.  No PDOP limit was applied. Mission planning was not 
conducted.  Data were not post-processed or edited in anyway. 
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Description – add an abstract explaining its data and purpose.   Let’s add a 
URL and hyperlink the text.  To do this, type Description, then highlight the text 


and click the hyperlink tool .  Next copy and paste this URL and click Apply. 
 
http://nctc.fws.gov/NCTCWeb/catalog/CourseDetail.aspx?CourseCodeLon
g=FWS-CSP7101 
 
 


 
 


Credits – add the person(s) name or organization name. 
 
USFWS National Conservation Training Center 


 
Use Limitations – add the following statement: 
 
Although these data and information have been processed successfully 
on a computer system at the USFWS, no warranty expressed or implied is 
made regarding the accuracy or utility of the data and information on any 
other system or for general or scientific purposes, nor shall the act of 
distribution constitute any such warranty. This disclaimer applies both to 
individual use of the data, and information, and aggregate use with other 
data and information. It is also strongly recommended that careful 
attention be paid to the contents of the metadata file associated with 
these data and information. The USFWS shall not be held liable for 
improper or incorrect use of the data and information described and/or 
contained herein.  
 
 


7. Select Topics & Keywords and fill-out the following sections: 
 
Topics - check the Structure and Transportation boxes 
 
Theme Keywords – type keywords separated by commas 
 
USFWS, GPS, GarminMap76CSx 
 
Place Keywords - type keywords separated by commas 
 
Riverside Park, Vero Beach, Florida 


 







GPS I: Field Mapping and Inventory                                                                                   2013 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


ArcGIS 10                                                                                      12 


8. Click on Citation Contacts and type your contact and contact information.  
 


9. Click on Details in the Resource section and change the Status to Completed. 
 


10. Next, click on Data Quality in the Resource section.  This is a great place to add 
entire documents that document the quality of your GPS data.  Since this is our 
first day and the data are pretty spare, just leave it alone and mode on. 


 


11. Click the Save button  when finished.   
 


12. Test out your Description URL. 
 


13. To add a thumbnail image to your metadata, simply click on the Preview Tab and 
select the Add Thumbnail icon on the Geography Toolbar.  Click back on the 
Details Tab to view the thumbnail. 


 
 


 
 
 


Congratulations!  You just created metadata for your GPS data.  
 
Note:  You can modify the .xml document that goes along with your shapefile to use 
as a metadata template for other datasets to save time.  Ask your instructors how 
this is done. 
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GPS Data for your Metadata  
 
If you plan your GPS data collection project, set objectives and created a geodatabase 
with domains and relationship tables, then most of this data should already exist in the 
attribute tables.  If not, much of these data can be copied and pasted from Trimble 
Pathfinder Office output files or manually input into the XML metadata file through 
ArcCatalog.   
 
Most of these data should be added to the Data Quality sections in your metadata.  No 
GPS section exists, so we have to make the best of it. 
 
 
GPS Project Planning 
 
 Project purpose and objective(s) 
 Datum and projection used to collected the field data 
 Date(s) and time data were collected 
 Data collector name(s) or initials 
 GPS receiver make and model (i.e. Trimble GeoXM 2005 Series) 
 GPS receiver firmware version and last date updated 
 GPS field software and version 


 
 
Data Collection Techniques  
Cite any GPS field data collection protocols if you used them. 
 


 Did you perform missing planning, if so what were the results?   


 What were the GPS data collection settings? In ArcPad refer to your GPS 
Preferences or Trimble GPSCorrect settings. 


 Logging rate used for lines and polygons 


 Did you use offsets, if so what were the conditions and settings? 


 Mode of data collection (walking, vehicle, ATV, boat, plane, hoarse, etc.) 
 
 


Differential Correction 
 


 Correction Type (real-time WAAS, Real-time beacon, post-processed) 


 Post-processing software and version 


 Name of the base station(s) used for correction 


 Settings used to perform the differential correction 
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Accuracy Indices 
These are automatically created with Trimble Pathfinder Office if the data are post-
process, however, the indices do not carry over to the attribute table(s) when using 
ShapeCorrect.  This is one major draw-back when using ArcPad. 


 


 Average Positional Dilution Of Precision (PDOP) 


 Maximum PDOP 


 Average Horizontal Precision (95% or 68% confidence ellipse) 


 Worst Horizontal Precision (95% or 68% confidence ellipse) 


 Vertical Precision (95% or 68% confidence ellipse) 


 Number of points recorded per feature 
 
 
Deliverables  
 


 Was the original GPS field data reprojected, if so what software and 
transformations did you use? 


 Did you edit the raw data to create the final layer, if so what process steps did 
you use? 


 Who or what organization will maintain and distribute the dataset? 


 Is this dataset updated on a regular schedule, or is this complete? 
 
 
 
Can you think of any additional data that would be useful to include in the GPS 
metadata?  If so, write them down below: 
 


1. _______________________________________________________________ 
 
2. _______________________________________________________________ 


 
3. _______________________________________________________________ 


 
4. _______________________________________________________________ 


 
5. _______________________________________________________________ 
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Exercise 3 – When is the Best Time to Collect GPS Data? 
 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 


 
 Use Trimble’s online GNSS planning tool to determine the best time period(s) to 


collect GPS data 
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Materials created by:  Eric Kelchlin, December 2011 


Revision: November 2012 


Software: Trimble’s online GNSS web application 


http://www.trimble.com/gpsdataresources.shtml  


 


Video:  Mission Planning: When is the best time to collect GPS data 


http://link.brightcove.com/services/player/bcpid1594664379001?bckey=AQ~~,AAAAv1R


Ro7E~,NyPVtykdKxWQxKBPhUcqCZ7y3oeLqfrM&bctid=1718424877001 
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Trimble’s online GNSS Planning Tool allows you to determine the best times to collect 
GPS data at any location and time span you choose.  This information is applicable to 
all GPS devices, not just Trimble units.   
 
SECTION 1 – Setting Your Station Parameters  
 
Watch the GNSS Planning Tool video tutorial (7:47 minutes in length).  This video 
shows you how to access the online planning tool, how to configure the settings and 
interpret the results.  Using what you learned in this video, go to the online tool, 
configure the settings and answer the questions in Section 2. 
 
Video Link: 


http://link.brightcove.com/services/player/bcpid1594664379001?bckey=AQ~~,AAAAv1R


Ro7E~,NyPVtykdKxWQxKBPhUcqCZ7y3oeLqfrM&bctid=1718424877001 


 
 
SECTION 2 – Determining When to Go Outside and Collect GPS Data 
 
Use the following settings when answering the questions: 
 
Satellite Library:  GPS only 
Location:  Vero Beach, Florida 
Cutoff :   0 
Date:    Tomorrow, starting at 8 am, 12 hour setting 
 
 
1. How many satellites make up the GPS constellation__________? 


 
2. How many are unhealthy___________? 


 
3. Based on visible satellites, what time interval(s) would be the best to collect 


accurate GPS data__________________________________________? 
 


 What is the greatest number of visible satellites______________?  
 


4. Based on DOP, what time interval(s) would be the best to collect accurate GPS 
data______________________________________________________? 
 


 What is the lowest DOP value______________?  
 


5. Should we be expecting poor radio transmissions tomorrow that will affect our 
GPS accuracy on the ground_______?   
 


 Why or why not_______________________________________? 
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Exercise 4 - Manually Calculating UTM Coordinates 
 
 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 
 
 Use a UTM Grid Reader to manually calculate Easting and Northing coordinates 


from a USGS topological map. 
 


 Create a new waypoint and manually edit the coordinates in a Garmin Map 
76CSx GPS unit. 
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Materials created by:  Eric Kelchlin (March 2007) 


Revision:  November 2012 
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SECTION 1 – How to Calculate UTM Coordinates from a Topological Map 
 
Use the UTM Grid Reader to calculate the coordinates for the Mt. Wesley Church from 
the USGS topological map.  We’ll do this together as a classroom exercise. 


 
1. Enter the UTM coordinate of the Mt. Wesley Church. 
 
 ___________________ Easting (X) 
 
 ___________________ Northing (Y) 


 
2. What is the Datum and Projection___________________________________?   


 
Where do you look for this information?_______________________________? 


 
 
SECTION 2 – Manually Entering Coordinates into the Garmin Map76CSx 
 
TASK 1 - Changing Garmin GPS Settings 
 
Since the datum is different than what we have been using in the field, you will first need 
change settings in the GPS unit to ensure that the new coordinates you are about to 
enter match those on the topological map.    
 


1. Turn on your Garmin GPS unit and wait until the Satellite Page appears.   
 


2. To view the setup parameters press the MENU button twice.  The Main Menu 
Page will appear. 


 
3. Select the Setup icon and press ENTER.  


 
4. Next, select the Units icon and press ENTER.    


 
5. Change the Position Format (i.e. coordinate system) and 


Map Datum fields to what is shown to the right.  Use your 
ROCKER keypad to select and highlight the field you need 
to change.  Press the ENTER button once on highlighted 
field to view an extensive list of coordinate systems or 
datums. Use the ROCKER keypad again to scroll through 
the list.  Once you find the new coordinate system or datum 
from the list, press the ENTER button to accept the change. 


 
6. Hit the PAGE or QUIT button to exit out of the Units page 


and save your changes. 
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TASK 2 – Creating and Editing a New Waypoint 
 


1. Create a new waypoint by firmly pressing down and holding the ENTER/MARK 
button for about 1 second, then release.  The Mark Waypoint page will appear.   


 
2. Use the ROCKER keypad to highlight the Location field and press ENTER.  A 


numeric keypad will appear. 
 


 


 
 


3. With the right arrow key highlighted, press the ENTER button to scroll through 
each coordinate value until you highlight the first value you wish to change.   


 
4. Use the ROCKER to select the number you want on the numeric keypad, press 


ENTER to add the number to the coordinate in the Location field.   
 


5. Enter the UTM coordinate of the Mt. Wesley Church.  When finished, select 


 on the keypad and press ENTER.   
 


6. Press the PAGE or QUIT button to accept the coordinate changes and exit the 
Waypoint page. 


 
7. Use the PAGE button to scroll to the Map Page and view the location of the Mt. 


Wesley Church. 
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Exercise 5 – Sampling Design and Uploading Data 


 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 
 
 Create systematic and random sampling designs to inventory wildlife populations 


and their habitats. 
 


 Upload point, lines and polygon shapefiles into the Garmin Map76CSx. 
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Materials created by: Eric Kelchlin (Jan 2013) 


Revision:  


Software: GME, DNRGPS 6.15, ArcGIS 10, SP5 


Directory Path:  CSP7101\Exercise5 


Datasets: Park_Units.shp, Buildings.shp 


MXD: Sample_Design.mxd 


Imagery: NAIP_2010.sid (UTM 17, NAD83) 
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SECTION 1 – Creating Sampling Points, Plots and Transects 
 
You will be asked to generate sampling points, plots or transects across a study area at 
some time in your career.  With the help of ArcGIS and GME (Geospatial Modeling 
Environment) you can easily create sampling a design for a wide array of inventory and 
monitoring applications.  Best yet, you can then upload this data into your Garmin unit 
and laydown the sampling design in the field. 
 
All data are located in the Exercise5 folder unless otherwise stated. 


 
TASK 1:  Create a Stratified Random Sample of Points 


 
1. Launch ArcMap and open the Sampling_Design.mxd map document. 


 
2. Create a stratified random 


sample of points within the 
park management units. 
 
 From ArcToolbox on the 


side bar open the Create 
Random Points tool 
(Data Management Tools 
> Feature Class).  Fill in 
the fields as shown here 
and click OK.   


 
 The Random1 shapefile 


will automatically appear 
in your Table of Contents 
(TOC). 


 
 Notice how the data were 


automatically stratified 
within each park 
unit/polygon.   If you 
wanted only 25 sampling 
points throughout the 
entire park, how would 
you do this? 


 
  







GPS I: Field Mapping and Inventory                                                                                    2013 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Sampling Design                                                                                      4 
 


3. Repeat the process and create a second layer, but this time change the number 
of random points and spacing to something different.  Name the shapefile 
Random2.   NOTE: you will get an error message if the inter-point spacing (i.e., 
minimum allowed distance) is too large for the number of random points you 
want. 
 


4. Next, add in the Building shapefile.  Let’s use the Building polygon layer to 
restrict where the random samples can occur.  We don’t want to place random 
samples on locations that are unsuitable.   
 


 Launch GME (Geospatial Modeling Environment) from the desktop.  
Select the titles radio button and change the Category filter to Sampling. 
 


 
 


 Let’s create another stratified random sample of points, but this time 
exclude the locations where the buildings occur.  Select the Generate 
Stratified Random Points command.  NOTE:  the Generate Random 
Points command does not stratify.  So if you want the points to be 
randomly distributed throughout the park as a whole, then this is the 
command to use. 
 


 Fill-in the fields as shown below.  Make sure to include the Building 
shapefile in the Optional:excl field.  Name the new file Random3. 


 
 The layer will not appear automatically in the TOC.  You will need to open 


ArcCatalog on the side bar, right-click on the Home folder and select 
Refresh to see the new shapefile.  Now, simply drag and drop the layer 
onto the map to view the random points. 


 
 Examine the distribution of your Random3 points.  Did any overlay the 


buildings? 
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TASK 2:  Create a Sampling Grid 
 


1. Remove the Building and random point layers from the TOC.  
 


2. Create a 100 meter x 100 meter square grid. 
 


 Minimize ArcMap, and re-open GME.  Select Generate Regular Points in 
Polygon. 
   


 Select the Park_Units polygon for the “in” field, and use 100 meters for 
both the “xdist” and “ydist” fields. 


 
 Name the output Grid100.  


 
 Add the Grid100 to the TOC from ArcCatalog.  Remember to right-click 


and select Refresh on the home folder to see any new layers! 
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 Notice how the points only reside within the Park_Units polygon.   
 


3. Create another 100 meter square grid, but this time make sure the FALSE radio 
button is checked in the “Optional:random” field.  This will align the grid to the 
upper left corner.  Name the shapefile Grid100False. 
 


4. Compare the results.  Which randomization method generated more points in the 
polygons, TRUE (default) or FALSE method?   
 
 


 
 
EXTRA: If you have time, generate another 100m square point grid using the Create 
Fishnet Tool in ArcToolbox (Data Management > Feature Class) and compare the 
results to the GME generated grids.  Tip: make sure you have the create label points 
box checked, or else no points will be generated. 
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TASK 3:  Create Sampling Plots  
 


Once you created your random points or point grid, it’s common that the sampling 
strategy requires an area to be sampled at those point locations.  Estimating percent 
cover of plant species, for example, is commonly done within a square frame known as 
a quadrat.  These quadrats are small, ½ to 1 meter square, and although we can easily 
create them using the Generate Shapes command in GME, it would be rather pointless 
to upload such small quadrats into our Gamin unit for field use.  Just bring the real 
quadrat out to the field and navigate to the sampling points. 
 
However, when you want to create a large plot with a specific dimension and sample 
within the plot, then GIS and GPS can help.  Why take the tape measure in the field 
when you have the plots and sample points uploaded into the Garmin unit?   


 
1. We’re going to create a 100 x 100 meter square plot in ArcMap using common 


editing techniques.  First, let’s start with a clean slate.  Select all the layers in the 
TOC except the NAIP_2010.sid imagery, right-click and select remove. 


 
2. Next, create a new polygon shapefile. 


 
 Open ArcCatalog from the sidebar.  Right-click on the Home folder and 


select New > Shapefile. 
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 Name the shapefile Sampling_Frame and change the Feature Type to 
Polygon. 


 


 This is a very important step!  Click the  button and then the 


 button to browse through the projected coordinate system list 
to select the appropriate projected coordinate system.  Click Add, OK and 
OK when done. 


 


 
 


 The Sampling_Frame layer will automatically be added to the TOC.  
Change the symbology to no color, increase the line size to 2 and change 
the color to red. 
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3. Start an editing session by selecting the drop-down arrow on the Editor Toolbar 
and select Start Editing.  The Create Features dialog will appear on the right-
hand side to the screen. 
 


 Zoom into  the main field in Riverside Park.   
 


 Select Sampling_Frame in the Create Features dialog to initiate editing, 
and then select the Rectangle Construction Tool. 


 


 
 


 Hover over the map with your mouse.  You should now see that your 
arrow has turned into a “+” symbol with a small box in the bottom right 
corner.  
 


 Left-mouse click on the map to create the first corner of the plot.  Move 
your mouse down, right-mouse click and select Horizontal. 
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 Right-mouse click again, and select Length.  Type in 100 and hit the enter 
key. 


  
 


 Right-mouse click one more time, and select Width.  Type in 100 and hit 
the enter key.  You should now have a 100 meter square plot. 
 


 If you wanted to move the plot, make sure the plot is still selected (i.e., 


highlighted in light blue) and simply use the Editor Tool arrow  on the 
Editor Toolbar to select the plot.  Hold down the left-mouse button and 
drag the plot to another location. 


 
 To complete the plot and save it, simply select the drop-down arrow on the 


Editor Toolbar and select Stop Editing and Yes to save your edits.  
 


 
 
 


4. Use GME to create 20 random points within the new Sampling_Frame polygon.  
Have the points be least 10 meters apart from each other.  Name the output 
Sample_Sites.    
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5. Finally, add labels to the Sample_Sites point layer.   
 


 Add the Sample_Sites layer to the TOC.  Right-click on the layer and 
select Label Features.  We need to point to the right field in our attribute 
table to get the correct labels. 
 


 Right-click on the Sample_Sites layer and select Properties all the way at 
the bottom of the menu.  Click on the Labels tab and change the Label 
Field to PNTID.  When we upload this layer into our Garmin Unit (Section 
2), these labels will carry over. 


 
 Your screen should look similar to the one below. 


 


 
 


 
TASK 4:  Create Sampling Transects  
 
In this last section were going to create another shapefile from scratch.  We’ll then 
digitize 100 meter long polylines (i.e., transects) and generate systematic points along 
these transects.  This sampling design is often used for bird point count transects and 
point-line-intercept vegetation surveys. 


  
1. To create a new polyline shapefile in the Exercise5 folder (the Home folder) and 


name it Transect100.  NOTE: A polyline is a line with 2 or more points/vertices. 
 


 Click the Edit button to assign a datum and coordinate system.   
 


 Select the  button and browse to the Exercise5 folder.  Select 


Sampling_Frame.shp and click  and OK. 
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 Click OK to finish the process.  Transect100 will appear in the TOC 
automatically. 


  
2. Change the symbology of the line to better see the line as it’s digitized on the 


Bing map.  I chose the Highway Ramp symbol.   
 


3. Start an editing session from in the Editor Toolbar.   
 


4. Notice that the Transect100 layer is not available for editing in the Create 
Features dialog.  We need to add the new layer to our Create Features 
template.   


 


 To do this, simply select the Organize Templates  button.   
 


 
 Next, select the Transect100 layer and click New Template, and Finish. 


 


 
 


 
  







GPS I: Field Mapping and Inventory                                                                                    2013 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Sampling Design                                                                                      13 
 


5. OK, lets create a 100 meter long transect. 
 
 Select the Transect100 layer in the new template and left mouse click on 


the map to start the polyline.   
 


 Drag the mouse down and right-mouse click.  Select Length in the pop-up 
menu.  Type 100 and hit Enter on the keyboard. 


 


 
 
 


 Drag the mouse in the direction you want the transect follow and left-


mouse click to create the second point.   Click the Finish Sketch  
button on the Feature Construction Toolbar, and you’re done. 
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6. Make two more 100 meter transects that run parallel to the first using the Editor 
Toolbar.  
 
 Click on the Editor button on the Editor Toolbar and select Copy Parallel. 


 
 Use a 20 meter distance shown below and click OK.  You should now 


have 3 transects, each one paralleling the other at a 20 meter distance. 
 


 
 
 


 Stop editing and save edits. 
 
 


7. Finally, we’re going to add sampling points at regular intervals along each 
transect. 
 
 First, create another new point shapefile and name it Transect_Points. 


 
 Start a new editing session. 


 
 Create a new template so the Transect_Points layer appears in the 


Create Features dialog, like we did in step 4 above. 
 


 Use the Editor Tool arrow  to select one of the transects.   
 


 Click on the Editor button and select Construct Points.  
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 Create a point every 10 meters, starting from the beginning of the 
transect.  See the example below. 
 


 
 


 Repeat this process for the other two transects. 
 


8. Add labels to the Transect_Points layer.  Notice that all the labels are 0, this is 
because the Id field in the attribute table is all zeros.  Let’s change this to 
sequential numbers. 


 
 Right-click on the layer in the TOC and open the Attribute table. 


 
 Right-click on the Id field header and select Field Calculator.   


 
 Next, double click on the FID field to add it to the code below and click 


OK. 
 


 
 


 Close the attributes table.  Stop editing and Save edits. 
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9. Save  the map document (MXD) and close ArcMap. 
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SECTION 2 – Uploading the Data into the Garmin Map76CSx 
 
In this section you will be using DNRGPS to upload the last two shapefiles you just 
created and saved in the Exercise5 folder (Transect100 and Transect_Points). 
 


 
1. Delete all the data on your GPS unit first before you upload any new data.   


 
 Turn on your GPS unit and go to the Altimeter Page from the Main Menu. 


 
 Select the Menu button once to bring-up the page specific menu. 


 
 Select Reset on the list, then scroll down to Select All, then scroll down 


and hit Apply.  This will remove all waypoints and tracks in once fell-
swoop. 


 
2. Attach you’re Garmin unit to the computer via the USB cable. 


 
3. Launch DNRGPS from the desktop.  


 
4. Load both shapefiles at once by Selecting File > Load From > File from the main 


menu. 
 


 Browse to the Exercise5 folder, select both shapefiles and click OPEN. 
 


 Click OK to accept Id as the IDENT field for both files.  You screen should 
look similar to the one below. 
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5. Next, select GPS on the main menu and click Upload All. 
 


 Select Named Tracks and OK.  You could go either way, but it would be 
better to have the tracks saved separately for easier access. 
 


 
 


6. Go to the Map Page on the GPS unit to view your data.  This is always a good 
idea before you head-out into the field.  Make sure your data is on the GPS unit, 
and in a way that you expected it to be.  Garmin loves to connect uploaded 
polygons because it treats lines and polygons as tracks. 
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Exercise 6 – Infrastructure Team Mapping Project 
 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 


 
 Conduct a multi-user GPS project 
 
 Edit line and polygon data in ArcMap 10 using advanced editing tools 
 
 Calculate length and area using the Calculate Geometry function 


 
 Quickly add GPS project information to the metadata  
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Materials created by:  Eric Kelchlin, August 2011 


Revision: January 2013 


Software: DNRGPS 6.15, ArcGIS 10 SP 5 


Directory Path:   CSP7101\Exercise6 


Imagery: NAIP_2010.sid 


Data: Infrastructure_Project_Summary.docx 


Map Document: Exercise6.mxd 
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GPS Project Summary 


Title:  Riverside Park Infrastructure Mapping Project 


Requested by: Joe Maintenance (joe_maintenance@fws.gov) 


Problem Statement: 
Riverside has a network of paved trails and parking lots throughout Riverside Park.  
Facilities Operations would like to map the paved trails in the Central and Island park 
units to determine how much paving material would be needed for a complete 
replacement in the near future (open the Exercise6.mxd to see the park units).  They 
would also like to determine how much asphalt would be needed to replace the large 
parking lot in the Central park unit.  A team approach will be necessary to speed-up the 
data collection process due to time constraints.  The trail segments should be merged 
into one layer with no dangles and gaps.  The parking lot will need to have the islands 
completely removed from the polygon to not overestimate the asphalt area.  Finally, 
Joe’s supervisor requires that metadata be completed for all GIS layers due to high 
employee turnover. 
 
Objectives & Methodology:  


1. In teams of 2, collect the polyline and polygon features using a Garmin 
Map76CSx.  Use a 2 second logging rate. 


2. Download the GPS data using DNRGPS (v6.15) from both GPS units onto one 
computer and save the data as a line or polygon shapefile in the NAD83 
UTM17 projection. 


3. Using the Editor Toolbar and Advanced Editing Tools, remove line dangles and 
gaps and then merge the trail segments into one layer.   


4. Add a Length (meters) field in the trail attribute table and use the Calculate 
Geometry function to calculate the length.  Multiply by a trail length of 1.2 
meters in width to calculate the area in square meters. 


5. Remove the islands from the parking lot polygon using the Erase Tool. 
6. Add an Area (square meters) field in the Parking Lot attribute table and use the 


Calculate Geometry function to calculate the area. 
7. Copy and paste this GPS project summary into the Description field of the 


metadata. 
 
Existing Data:   


 Exercise6.mxd map document, NAIP_2010.sid imagery, and the 
Park_Units.shp layer 


 
Deliverables: 


1. To answer the question: how much paving material is needed for the trail and 
parking lot (square meters). 


2. A “clean” trail and parking lot shapefile with length and area calculations in the 
attribute tables. 


3. Metadata with the GPS project summery in the description field.  
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Items to Keep in Mind 


1. You have to decide where to start and stop the trail.  You can’t just turn the 
GPS unit on and walk….the result will be a connected spider web of 
overlapping useless data.  Map trails in segments. 


2. This is a team project, so work together to collect the field data.  You may want 
to have one person get the parking lot and the other person the trails, but there 
are a lot more trails than parking lot.  


3. Be careful not mix-up manually saved tracks and automatically saved active 
track logs when you save the line and polygon data from DNRGPS after the 
data download.   This will result in duplicate layers in ArcMap. 


4. Work on one computer when you come back from the field.  You can split the 
data management duties or not.  The decision is it’s up to each team. 


5. This exercise is purposely designed to push you’re GIS skills into uncharted 
territory…so don’t be shy to ask the instructor or neighbor for help. 


 
 
SECTION 1 – Downloading and Saving Field Data 


 
All data are located in the CSP7101\Exercise6 folder.   
 


1. Download your trail (line) and parking lot (polygon) data onto a single computer.  
Save all you’re work in the Exercise6 folder. 


 
 Use either the GPS or Tracks on the main menu in DNRGPS to download 


the data. 
 


 
 


 Save the named tracks or Active Track Log segments, depending on how 
you collected and saved the data in the field.  Did you keep everything in 
the active track log and not save any tracks directly, or did you save each 
polygon or line segment separately.  If you chose the latter, then save the 
named tracks, otherwise save the Active Track Logs. 
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 Make sure your projection information is correct before you save the data. 
 
 


2. Open the Exercise6.mxd and add the GPS field data. 
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SECTION 2 – Clean-up the GPS Trail Data 
 
This section illustrates some common editing tasks in ArcMap that are often utilized 
to clean-up GPS line and polygon data.  Your objective is to connect all the line 
segments together, remove dangles and gaps.   You can also adjust any poor data 
locations using the background imagery as a reference.  You might only need to 
perform a couple tasks. 


 
 
TASK 1: Set the Stage 


 
1. Right-click in the “gray area” on the main toolbar and select the Snapping and 


Advanced Editing Toolbars.   Move the toolbars to a desired location. 
 


 
 


2. Click on the Snapping drop-down arrow and make sure Use Snapping is 
checked.   


 
 Make sure all 4 snapping buttons on the toolbar (Point, End, Vertex and 


Edge) are depressed. 
 


 Select the Snapping > Options and set the snapping tolerances to 10.  
 


 
TASK 2: Connect Broken Lines 
 


1. Start an editing session by selecting the drop-down arrow on the Editor 
Toolbar and select Start Editing. 


 


2. Click on the Edit Tool  on the Editor Toolbar.  
 


3. Zoom into  the area you will be working in.  
 


4. Using the Edit Tool , double click on the line that you want to edit to show 
its vertices (green boxes). 
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5. Place your mouse over the last vertex until it becomes a box surrounded by 


arrows.  Left click and drag the vertex to the desired location on the other line. 
Notice how the vertex “snapped” to the edge of the other trail. 


 
6. Click on the Finish Sketch icon on the floating Edit Vertices toolbar or 


anywhere on the map to accept your changes.  
 


 
 
 


7. If you make a mistake, use the undo  button on the Standard toolbar. 
 


8. To insert a vertex, click on the Insert Vertex  tool on the Edit Verticies 
toolbar. 
 


9. To delete a vertex, click on the Delete Vertex  tool on the Edit Verticies 
toolbar. 
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TASK 3: Trim lines 
 


1. Zoom in  to the area you will be working in. 
 


2. Use the Edit tool  to click once on the line which will be used to trim the 
desired line.  We will trim the red line where it crosses the selected (blue) line. 


 


3. Click on the Trim tool  on the Advanced Editing toolbar. 
 
 
4. Now, click on the red trail line above the blue selected trail to remove the 


overshoot.  
 


 
 
 
TASK 4: Split lines 
 


This is a useful tool when you have to a lot of vertices to delete and you don’t want to 
waste your time deleting each one separately.  The split tool cuts the line so you can 
delete entire line segments. 


 


1. Zoom in  to the area you will be working in.  Highlight the trail to split with 


the Edit tool . 
 


2. Click on the Split Tool  on the Editor toolbar. 
 
 
3. Click on the line where you want the split to occur.  Select the line segment you 


want to delete and press the Delete Key. 
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SECTION 3 - Calculate Trail Length and Area  
 


1. Merge all the trail segments into one polyline after you’re done with the line 
edits. 
 
 Select all the trail segments while still in edit mode.  Then click Merge in 


the Editor Toolbar.  
 


 
2. Open the attribute table and add two new fields from the Table Options drop-


down menu  .  Name the fields Length and Area.  Change the type to 
Float (i.e., a number with decimal places) with the Precision and Scale values 
as shown below.   Precision is the number of digits in a number, and Scale is 
the number of digits right of the decimal place. 
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 To calculate length in meters, simply right-click on the Length field and 
select Calculate Geometry.  You’ll be warned that you are doing something 
outside of an editing session.  Just go for it and click OK.   Change the 
Property and Units as shown below.  Click OK. 
 


 
 


3. To calculate 2-dimensional area of a line, right-click on the Area field and select 
Field Calculator.  Create the following expression and click OK. 
 


[Length] *1.2 
 


4. What’s the total trail length ________(meters) and Area_________(Sq meters)? 
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SECTION 4 – Erase the Islands and Calculate Parking Lot Area  
 
Erasing the islands?  Has the man lost it?  Perhaps, but what we’re referring to here is a 
tool called Erase that removes inner overlapping polygons and makes donut holes in 
the larger main polygon.  The result is a clean polygon ripe for area calculation. 
 


1. We need to make a separate layer that contains only the islands for the Erase 
Tool to work properly. 
 
 Start an editing session.  Open the Parking_Lot attribute table and select 


all the islands.   
 


 Combine all the island polygons into one using the Merge tool on the 
Editor Toolbar. 


 


 
 


 Close the attribute table and stop the editing session. 
 


 With the island polygon still selected in the attribute table, right-click on the 
Parking_Lot layer in the TOC and select Selection > Data > Export Data. 


 
 Name the new layer Islands.  It will automatically appear in the TOC. 
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2. Next, use the Erase Tool to make donut holes in the Parking_Lot layer.   
 


 Type Erase in the Search box or open ArcToolbox and browse to Analyst 
Tools > Overlay to find the tool. 


 
 Fill-in the fields as shown below. 


 


 
 
 
 


3. Add an Area field in the Parking_Lot_Final attribute table and calculate the total 
area in square meters as before.  If your number seems really small than try to 
think in hectares.  How many square meters in a hectare______________? 
 


4. What is the Area of the Parking lot without the islands_______(square meters)? 
 


 
 
  







GPS I: Field Mapping and Inventory                                                                                   2013 
U.S. Fish and Wildlife Service                              National Conservation Training Center 


 


Infrastructure Project                                                                                      13 


SECTION 5 - Add GPS Project Summary to the Metadata 
 
This is a really quick way to add detailed metadata to your GIS layer.  Most of us simply 
do not have the time to sit down and fill-out all the mandatory 11 sections of metadata.  
So, for practical purposes, l highly recommend that you add the GPS project summary 
to the description field.   The GPS project summary contains plenty of information for 
someone else to evaluate the data quality, and that is essentially the main reason for 
metadata. 
 


1. Launch ArcCatalog  from the desktop.  
 


2. To add metadata, simply highlight the Trails layer, select the Description tab 


and select the Edit tool  in the Items Description window.    
 


3. Click Item Descriptions in the Overview section and scroll down to 
Descriptions. 


 
4. Open Windows Explorer and copy the text from the 


Infrastructure_Project_Summary.docx file in the Exercise6 folder and paste 
in the Items Descriptions field. 


 
5. Click Save.  That’s it!  As long as you have a GPS project summary you can 


create quick and easy metadata. 
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Exercise 7 - Final Projects (Teams) 
 
 
 
At the conclusion of this session you will be able to: 
 


 
 Demonstrate real world natural resource management applications of GPS 
 
 Document GPS conditions using Trimble Mission Planning software 
 
 Transfer data to and from your GPS device (upload and download) using 


DNRGarmin software 
 
 Add GPS field data to a map document in ArcMap and/or Google Earth 
 
 Create Metadata for a GIS layer using ArcCatalog 


 
 Create a GPS project summary 
 
 Present your findings to the class; share the trial and tribulations of a GPS 


master 
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Materials created by:  Eric Kelchlin, August 2011 


Revised:  January 2013 


Software: DNRGPS 6.15, ArcGIS 10 SP5 


Directory Path:  C:\CSP710\Exercise7 
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Please read all the instructions before you start! 
 
Project Guidelines 
 
 This is a team project (teams of 2), so work together to get the project done in 


time.   
 
 Use the example GPS project summary in the Exercise7 folder to help you 


design your own GPS project.  You will be responsible for showing this to your 
instructor and having it approved before heading out into the field.  You have a 
lot of time to complete this, so think big.  Also, you don’t have to do the project in 
the same park; you can go anywhere in town, go to the beach, find another park, 
whatever works for you. 
 


 Use Trimble’s GNSS planning software to document your GPS conditions. 
 
 Use averaging when collecting all point data and document the logging rate. 


 
 Save the GPS field data as shapefiles in the Exercise7 folder along with your 


PowerPoint presentation (see below)  
 
 Create metadata for one shapefile ArcCatalog.  Copy and paste the GPS project 


summary to the description if you run out of time. 
 
 


Presentation Guidelines 
 
Create a 5 -10 minute PowerPoint presentation to show us what you accomplished.  
This is a team effort, so work together on one computer.  
 
Your presentation should include: 
 
 Your project scenario and objectives; what were you trying to accomplish and 


why? 
 
 Describe your data collection methodology. 


 
 Show your mission planning results. 


 
 Show us your data and map.  Use screen shots in your PowerPoint to do this.   


 
 Show your metadata for one layer. 


 
 Discuss any problems you ran into and solutions you used to solve them. 


 
 Would you do things differently next time and why? 
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Appendix - Getting Your Garmin Connected and Updated 
 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 


 
 Download and install software that will allow your computer to interface with your 


Garmin Map76CSx 
 


 Download and install the Garmin WebUpdater program and update the software 
and firmware controlling your Garmin GPS unit 
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Materials created by:  Eric Kelchlin, February 2008 


Revision: February 2010 


Notes: GPS Map76SCx OS version = 3.90, USB Driver version 2.23 


Directory Path:  D:\TEC7132\Utilites\Garmin 


*The software is located in the TEC7132\Utilites folder if you do not have internet 


access. 
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NOTE:  Make sure you have administrative privileges to install software on your 
computer before you proceed. 
 
SECTION 1 – Garmin USB Driver Installation 
 
A driver is software that allows your computer to communicate with external hardware 
or devices.  The driver software for the Garmin Map 76CSx does not come standard 
with Windows operating system.  We need to download the driver directly from the 
Garmin website and manually install the driver on our computer.  
 
 


1. Open Internet Explorer  and open the Google web page. 
 


2. Type “garmin usb driver” in the Google search field and hit the Enter Key. 
 


 
 
 


3. Click on the Garmin: USB Driver Updates & Downloads link to access 
Garmin’s support page. 
 


4. Click on the Download link next to USB Drivers Ver. 2.23 as of December 1, 
2009. 
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5. Click .  A Windows Internet Explorer – Security Warning screen will 


pop-up asking “Do you want to run this software?” Click  again. 
 


 
 


 
6. A Garmin USB Driver installation screen will appear.  Click Install Garmin USB 


Drivers.   
 


 
 


 
7. Click on the box to accept the terms in the license agreement.  Click Next twice.  


Click Done when the setup is complete. 
 


8. Attach your Garmin Map76CSx to the USB cable and connect the cable to a 
USB port (look on the left side of your monitor).   


 
9. Turn your Garmin unit on (press and hold down the red button). 


 
10. The computer will open the Found New Hardware Wizard and find the driver.   


 
Congratulations!  You just established a connection between your Garmin GPS Map 
76SCx device and your computer. 
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SECTION 2 – Updating Garmin Software and Firmware 
 
Your Garmin GPS device is a small handheld computer with GPS controller and 
Operating System software that needs to be periodically updated.  Garmin provides free 
web software that makes updating your Garmin GPS device a snap!  These instructions 
will walk you through the process of downloading the Web Updater software, installing 
the software and updating your Garmin GPS unit.  Your GPS data will NOT be deleted 
from your GPS unit during this process, so don’t worry if you have yet to transfer field 
data to your computer 
  


1. On the Google web page type “Garmin Web Updater Windows” in the search 
field and hit the Enter Key. 


 
2. Click on the Garmin:WebUpdater for Windows Updates & Downloads link. 


 
3. Click on the Download link next to WebUpdater Ver. 2.4.2 as of April 22, 2009.   


 


4. Click  after the download is complete.  A Windows Internet Explorer 
– Security Warning screen will pop-up asking “Do you want to run this 


software?”.  Click  again. 
 
5. The Garmin WebUpdater installation screen will appear.  Click Next.  Click on 


the box to accept the terms in the license agreement.  Click Next twice.  Click 
Done when setup is complete.   


 
6. The WebUpdater program will automatically start-up and search for updates for 


your Garmin Map76CSx.  Follow the onscreen WebUpdater instructions to 
install any software updates.  A WebUpdater icon will be placed on your 
desktop for future update checks. 
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Garmin GPSMap 76CSx 


Model Overview & Data Collection Procedures 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 


 Utilize the keypad and raised buttons to maneuver through screen pages 
 
 Differentiate screen pages, describe their uses and access screen specific 


options 
 


 Setup and configure the GPS unit for data collection 
 


 Create waypoints (e.g., points) and tracks (e.g., line and polygon features) 
 


 Navigate to a waypoint 
 


 Delete saved waypoints and tracks 
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Materials created by:  Eric Kelchlin, June 2009 


Revision: August 2011 


Notes: GPS Map76SCx OS version = 3.20 
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Contents 
          
Keypad Usage/Button Overview 4 


Default Screen Pages 5 


Initial Setup and Configuration 9 


Customizing Your Screen Pages 9 


System, Time and Unit Settings 10 


Field Data Collection Procedures 12 


Creating a Waypoint (i.e., Point Feature) 13 


Creating a Waypoint Using Averaging 14 


Deleting Waypoints 15 


Manually Entering Coordinates 16 


Navigating to a Waypoint 17 


Creating a Line or Area Feature Using Track Logs 19 


Area Calculation in the Field 21 


Deleting Saved Tracks  23 


 
 
NOTE:  The instructions for this device were created using software version 3.20.  It is 
always a good idea to update your Garmin GPS device with the latest software.   You 
can download the latest software version for your Garmin device along with detailed 
instructions on how to perform the installation from the following website. 
 
http://www.garmin.com/support/download.jsp 
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Keypad Usage/Button Overview 
 
POWER - Turns the unit on and off.  With a quick press of the button you can “pop-up” 
a slide bar to adjust the backlighting. 
 
PAGE/COMPASS - Allows you to sequentially scroll through six main display pages.  
Press, hold, and release to turn the electronic compass on or off. 
 
MENU – Press and release this button to view an Options Menu pop-up screen to 
modify the setting on a current page.  Press twice to access the Main Menu Page. 
 
FIND/MOB - Press this button to open the Find Menu Page where you can select 
waypoints to edit or navigate too.  Press and hold down to create man overboard (MOB) 
point.  
 
ENTER/MARK – Press to create a waypoint, activate selected fields, confirm menu 
options and select keyboard keys.   
 
QUIT - Returns you to a previous page and allows you to restore a data field’s previous 
value.  
 
IN & OUT ZOOM – Press to increase or decrease the scale (i.e., zoom in or out) of a 
map. 
 
ROCKER - Press the edges of this button to move the cursor up, down, left or right. 
 


Internal GPS 
Antenna 


Page Scroll/ 
Compass 


Menu 


Enter/Mark  
Waypoint 


Zoom In/Out 


Find/MOB 


Power/Backlight 


Quit/ 
Page Scroll 
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Default Screen Pages 
 
Scrolling through the screens: use the PAGE button to scroll forward or the QUIT button 
to scroll backwards through the screen pages. 
 
Page customization:  nearly all screen pages can be customized by accessing the 
Options Menu within each page.  Press MENU once while on a screen page you want 
to modify and a page specific Options Menu will pop-up.  Use the KEYPAD to highlight 
desired fields and ENTER to make selections. 
 
 
Screen Status Bar – at the top of each screen page, the status bar provides status 
information for multiple unit features. 
 
 


 
 
 
Satellite Page - This page contains useful satellite status information, as well as your 
estimated accuracy, direction of travel, and current coordinates. 
    


 
 
 


 


Power icon, the 
Battery icon will
show when not
plugged-in 


Satellite signal Status 
icon.  Blank when searching for 
satellites, 2D with 3 satellites or 
less, and 3D with 4 or more 
satellites acquired.


Electronic Compass icon-
appears when on


USB Cable 
Connection 
icon


Backlight Display
icon – appears 
when onPower icon, the 


Battery icon will
show when not
plugged-in 


Satellite signal Status 
icon.  Blank when searching for 
satellites, 2D with 3 satellites or 
less, and 3D with 4 or more 
satellites acquired.


Electronic Compass icon-
appears when on


USB Cable 
Connection 
icon


Backlight Display
icon – appears 
when on


Heading bug – Indicates
direction of travel


Satellite icon – Solid color is
an acquired satellite, blinking
empty icon is not acquired


Satellite signal strength bar –
Higher is better.  A “D” will appear
In bar when WAAS is received


Current location 
Error estimate


Outer circle –
Represents the 
horizon


Inner circle –
Represents 45 
degrees from
the horizon


Options Menu
Heading bug – Indicates
direction of travel


Satellite icon – Solid color is
an acquired satellite, blinking
empty icon is not acquired


Satellite signal strength bar –
Higher is better.  A “D” will appear
In bar when WAAS is received


Current location 
Error estimate


Outer circle –
Represents the 
horizon


Inner circle –
Represents 45 
degrees from
the horizon


Options Menu
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Trip Computer Page – Provides many useful statistics while traveling on a long hiking 
or road trip, such as a trip odometer, current speed, and much more. 
 


 
 
 
Map Page – Track your movements and measure distances in real-time.  The built-in 
base maps show lakes, highways, rivers, towns and points of interest (POI).  You can 
also purchase topographic maps from Garmin that can be uploaded into this GPS 
device.  Use the IN or OUT buttons to change the map scale. 
 


 
 
 


Options MenuOptions Menu


Options MenuOptions Menu
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Active Route Page - This page is used when navigating routes or Gotos.  Use routes 
when you want to establish a sequence of intermediate waypoints to get to a final 
destination. This page is visible only when you have an active route. 
 
 


 
 
 
 
Compass Page – Great for navigation!  When the bearing pointer on the compass 
points up, then you are headed in the right direction.  A course pointer can also be used 
to show how far off course you are from the target (i.e., transect).   The Sight ‘N Go 
option allows you to set a course to an object in the distance and navigate to that object.  
Current velocity, distance to destination and many other statistics can be shown to help 
guide you to your target.  
 
 


 
 


Options MenuOptions Menu


Bearing Pointer Course Pointer Sight ‘N Go


Options Menu


Bearing Pointer Course Pointer Sight ‘N Go


Options Menu
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Altimeter Page – Shows the current elevation, rate of ascent/descent, a profile of 
elevation changes over distance or time, or a profile of pressure changes over time.   
Use the Reset field on the Options Menu for an easy way to delete all point, line, and 
polygon data on the GPS receiver.  
 
 


 
 
 
Main Menu Page – This page allows you to access some very useful hidden pages, 
especially the Setup Page where you configure all the settings and the Tracks Page 
where you create lines and polygons.  
 
 


 


Options MenuOptions MenuOptions Menu
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Initial Setup and Configuration 
 
Customizing Your Screen Pages 
 
The following steps document how to remove unwanted screen pages and add those 
you’re more likely to use in the field (i.e., Satellite, Map, Compass, Track and Area 
Calculation pages) 
  
How to Remove a Page 
 


1. Hit MENU twice, or scroll through the pages until you find the Main Menu Page. 


2. Use the KEYPAD to scroll down and highlight the Setup  icon and press 
ENTER to access the Setup Menu. 


 


3. Use the KEYPAD to scroll down and highlight the Page Sequence  icon 
and press ENTER to access the Page Sequence Setup screen. 


 
4. Highlight the page you want to remove and press ENTER.  A popup menu will 


appear, highlight Remove and press ENTER to delete the page. 
 


 
How to Add a Page 
 


1. Repeat steps 1-3 above to get to the Page Sequence Setup screen.  Scroll 


down and highlight the  field and press ENTER to access the Add 
Page popup menu.  Highlight the page you want to add and press ENTER.  The 
Area Calculation page and the Tracks page are the best pages to add to your 
default screen page selection. 


System, Time and Unit Settings 


Page Sequence Setup screensPage Sequence Setup screens
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You will need to ensure that several critical parameters are set before going out into the 
field to capture GPS points.  These include System, Time and Unit settings.  Once you 
set these parameters, they will become your default settings.  However, it is wise to 
make a habit of checking these parameters each time you begin data collection.  This is 
especially true if others have unknowingly changed a critical setting which could affect 
an entire day’s worth of data collection. 
 
Access the Setup Menu 
 


 Press the MENU button twice.  Use the ROCKER key to select the SETUP 
icon and press ENTER. 


 


 
 


Key System Settings 
 


 Make sure the following key parameters are set before you collect field data. 
 


 
 


GPS – while outside operate in Normal or 
Battery Saver mode.  Change to GPS off while 
in the office to save battery life.


WAAS/EGNOS – stay on Enabled mode to 
ensure that the satellite based differential 
correction is being used.


Battery Type – choose between Alkaline (most 
common type), NIMH or Lithium Ion.


GPS – while outside operate in Normal or 
Battery Saver mode.  Change to GPS off while 
in the office to save battery life.


WAAS/EGNOS – stay on Enabled mode to 
ensure that the satellite based differential 
correction is being used.


Battery Type – choose between Alkaline (most 
common type), NIMH or Lithium Ion.
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Time Format – 12 Hour or 24 Hour modes.


Time Zone – select the correct time zone for 
your area.


Time Format – 12 Hour or 24 Hour modes.


Time Zone – select the correct time zone for 
your area.


Position Format – select UTM UPS, this is the 
USFWS standard projection format.


Map Datum – select NAD83, this is the USFWS 
standard datum format.


*All units should follow the metric system.


Position Format – select UTM UPS, this is the 
USFWS standard projection format.


Map Datum – select NAD83, this is the USFWS 
standard datum format.


*All units should follow the metric system.
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Field Data Collection Procedures 
 
Before you start taking data - look at the Satellite screen page to make sure that: 
 


 You have a 3D position fix, 
 
 You have the lowest possible error value for your application, and  
 
 If possible, you have a “D” in the satellite signal strength bars.  This “D” 


indicates that you are receiving real-time differential correction signals from 
the geostationary WAAS satellite (Wide Area Augmentation System).  
However, you must have a clear view of the sky to get the WAAS signal, so 
you may not always get WAAS. 


 


 
 
 
Once you have a 3D GPS position fix and the error level is within the range required for 
your application, then you are ready to begin collecting data.  Be sure that you know 
your particular project’s standard operating procedure for the maximum allowed 
error value before you begin using the unit to collect data! 
 
 
NOTE: Before the GPS receiver can begin tracking satellites and determine its location, 
it internally downloads a current “almanac” file from the closest satellite.  This file 
updates the receiver’s internal clock and provides information on the satellite 
constellation.    


Estimated
Error Value


Real-time 
Differential 
Correction 
with WAAS


3D Position Fix


Estimated
Error Value


Real-time 
Differential 
Correction 
with WAAS


3D Position Fix
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Creating a Waypoint 
 
This is the quick method for collecting a waypoint: 
 


1. Hold the unit over the point you wish to record.  Keep the unit away from your 
body for better reception.  If your error level bounces up to an unacceptable 
range, you can rotate your body so the unit can try locking onto another satellite 
configuration which may provide a better fix.  


 
2. FIRMLY press down and hold the ENTER/MARK button for about 1 second, 


then release.  This is a toggle switch that brings-up the Mark Waypoint Page.   
 


 
 


3. Select OK (highlighted by default) and press ENTER.   Your waypoint has been 
saved.  That’s it! 


 
 
 
NOTE: The next sequential unused waypoint number is the ID 
for your new waypoint.  However, you can change the 
waypoint ID before saving by scrolling up with the ROCKER to 
highlight the Waypoint ID field, and press ENTER.  A keypad 
will appear that you can use to create your own waypoint ID.  
 
You can change the waypoint symbol before saving by 
scrolling up with the ROCKER to highlight the symbol field, 
and press ENTER.  A list of symbols will appear that you can 
select from.  The new symbol will be the default for all 
waypoints until you make a new selection. 
 
 
Creating a Waypoint Using Averaging 
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This method involves remaining stationary at your position for a set length of time.  The 
GPSMap 76CSx will average all of the readings together to calculate your position.  
Averaging will achieve a much higher level of accuracy. 
 


1. Repeat steps 1 and 2 as listed above.  Before you hit the OK button, scroll over 
to highlight the  button and press ENTER.  The Averaging Location 
screen will appear.  Do not move while in averaging mode.  Watch the value in 
the Estimated Accuracy field change as the device averages.  The value in 
the Measurement Count field lets you know how many waypoints are being 
used in the to calculate the average (1 waypoint/Sec).  When the measurement 
count reaches what you have established for your application, press ENTER to 
save.    


 
2. Use the ROCKER to highlight OK and press ENTER.  Your average waypoint 


has been saved. 
 
NOTE:  When establishing standards for your office, you may want to test using 
different lengths of time for averaging.  Most applications benefit from a 10, 30, or 
even 60 second average; depends on the level of accuracy you’re trying to 
achieve.   
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Deleting a Single Waypoint 
 


1. Press the FIND/MOB button to access the Find Page.   
 


2. Use the ROCKER key to highlight the Waypoints icon and press ENTER. 
 


3. Highlight the waypoint to delete and press ENTER.  
 


4. Highlight the Delete button and press ENTER.  A screen will appear asking you 
if you really want to delete the waypoint, select Yes and press ENTER.   


 


 
Deleting All Waypoints 
 


1. Repeat steps 1 and 2 above, but instead of pressing ENTER, press the MENU 
button. 


 
2. Use the ROCKER key to select Delete… and press ENTER. 


 
3. Select All Symbols and press ENTER.  A screen will appear asking you if you 


really want to delete all waypoints, select Yes and press ENTER. 
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Manually Entering Coordinates 
 
Coordinates can be obtained from a topographic map, your GIS, or other sources and 
entered into your GPS unit.  You enter waypoints individually from the Waypoint page.  
You must ensure you have the proper datum and coordinate system specified in your 
setup parameters.   
  


1. First create a new waypoint by firmly pressing down and holding the 
ENTER/MARK button for about 1 second, then release.  The Mark Waypoint 
page will appear.   


 
2. Use the ROCKER key to highlight the Location field and press ENTER.  A 


numeric keypad will appear. 
 


 
 


3. With the right arrow key highlighted, press the ENTER button to scroll through 
each coordinate value until you highlight the value you wish to change.   


 
4. Use the ROCKER to select the number you want on the numeric keypad, press 


ENTER to add the number to the coordinate in the Location field.  At the end of 


coordinate entry, select OK   on the keypad and press ENTER.   
 


5. Press the QUIT or PAGE button to accept the coordinate changes and exit the 
Waypoint page. 
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Navigating to a Waypoint 
 


Use the FIND button from the keypad to select a waypoint you wish navigate to.  The 
Compass Page or Map Page is used to help guide you in the right direction. 
 


1. Press the FIND/MOB button to access the Find Page.   
 


2. Use the ROCKER key to highlight the Waypoints icon and press ENTER. 
 


3. Highlight a waypoint you wish to go to, press ENTER.   
 


4. Ensure that the Go To button on the bottom right of the screen is selected, 
press ENTER. 


 


 
 


 
5. The Map Page will appear showing the location of your selected waypoint 


(which will now have the waypoint ID as a text label) relative to YOUR location 
on the map.  Your location on the map is identified by the arrow  symbol.  
The tip of arrow will point in the direction your traveling.  


 
6. Use the ZOOM IN and OUT buttons to find the general direction that you need 


to travel before you start walking to your Navigation Target.  You must be in 
motion in order to receive accurate information from your unit on what direction 
to take!  If you stop moving, the GPS unit will be unable to use the satellite 
signals to calculate your direction and speed of travel; the arrow   symbol 
will spin while your standing still, but it will be useless for navigation. 
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7. Once you find the general direction you need to travel toward, press the PAGE 
button until you find the Compass Page.  Use the large red compass arrow to 
identify the direction you should be traveling toward, AND the value displayed in 
the Distance to Next field to determine if you are heading in the right direction 
and getting closer to your target.  When the bearing pointer on the compass 
points strait up, then you are headed in the right direction.   


 


 
 


NOTE: Press the MENU button while on the Compass Page to add or change 
the data fields if the Distance to Next field is not visible.   


 
8. As you approach your destination, a message will appear letting you know that 


you are arriving at the location.  Once the displayed distance to the waypoint 
has dropped to less than 5 or 10 meters, then you should begin looking for your 
feature or marker.  Once the distance to the location is less than the 
accuracy/error value, the navigation information is too general to be accurate. 


Your Location


Accuracy Circle


Navigation Target


Shortest Travel Route


Your Location


Accuracy Circle


Navigation Target


Shortest Travel Route


Map Page
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9. To cancel navigation - press the MENU button while on the Compass or Map 
Page and use the ROCKER key to select Stop Navigation and press ENTER. 


 
 
 
Creating a Line or Area Feature Using Track Logs 
 


1. Obtain a 3D GPS location and ensure your estimated accuracy is within the 
tolerance you have established for your application. 


 
2. Use the PAGE button to scroll to the Menu Page (or hit the MENU button 


twice)  


3. Use the ROCKER key to select the Tracks  icon and press ENTER.  
This brings you to the Tracks Page. Refer to the “Customizing Your Screen 
Pages” section on how add this page permanently to your list.  


 
4. Ensure your recording mode is set to Off.  
 


 
 


5. Use the ROCKER key to select Setup  and press ENTER. 
 
6. Insure that Wrap When Full box is unchecked.  Otherwise your data could be 


overwritten if you run out of memory space.   
 
7. Set the Record Method to Time. 
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8. Set the Interval to an appropriate setting for your application.  An interval 
setting of 3 seconds works well (00:00:03) if walking a trail or weed patch 
perimeter. 


 


9. Scroll down to the  button and hit ENTER.  Make sure 
the Log Track To Data Card box is checked.  (Notice that you can select the 
Delete All Button on this Track Log Data Card screen to delete all saved 
tracks on the card.) 


 
 


NOTE:  Leave the Log Track To Data Card unchecked if you have a pre-
programmed map Data Card from Garmin.  The unit has 24 MB of RAM, so you 
shouldn’t run into memory shortage issues. 
 


10.  Hit the QUIT key twice to get back to the Tracks Page.  
 


11.   Use the ROCKER key and select the  button to erase the active track 
log memory.  Select Yes when asked “Do you really want to clear the track 
log?” 


 
12. Move to the starting location of your line or area feature.  Select the On button 


and press ENTER to begin recording.  Feel free to move to the Map Page while 
mapping the feature to monitor your work.   


 
13. When finished delineating the line, go back to the Tracks Page and set your 


recording mode to Off.  Press QUIT to exit the Tracks Page. 
 


14.  Repeat steps 12-13 to record additional line or area features. 
 
NOTE: You can also save the active track log (up to 20 tracks). If saving track logs, 
be aware that your data will be simplified to save memory space.  Keep the logging 
TIME or DISTANCE interval rate small to avoid oversimplification. 
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Calculating Area in the Field 
 


1. Add the Area Calculation Page to your default page selection list.  Refer to the 
“Customizing Your Screen Pages” section on how to do this.  


 


 
 


 
2. Ensure your recording mode on the Track Pages is set to Off and the logging 


settings are set as shown below (if walking around the perimeter).   
 


 
 
 


3. Move to the starting location of the feature you want to delineate in the field.  
With the Area Calculation Page open press the ENTER key to start logging.  
The Start button at the bottom of the page will change to Stop. 
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4. When your finished walking the perimeter of your field feature press the ENTER 
key to stop logging.  The  button will appear as well as an area 
calculation.  You can change the area units by scrolling through the list. 


 


 
 


5. Ensure that the  button is highlighted and press the ENTER key to 
save the area feature.  Rename the feature if necessary, or change the Area 


units here as well, then scroll down to highlight the  button to save the 
area feature.  Notice also that this is a quick way to calculate perimeter distance 
or length of a line. 


 


 
 
NOTE:  When uploading tracks via DNR Garmin you will see and Active log of the area 
feature and a saved log of the area feature.  The saved log will have the name as listed 
in the Name field above, in this case 08-MAR-07 02.  
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Deleting Saved Tracks  
 


1. From the Tracks Page, scroll down using the ROCKER key and highlight the 
track you want to delete and press ENTER.  Select the Delete button and select 
Yes when asked “Do your really want to delete track”. 


 


 
 


 
NOTE: To delete all Saved Tracks at once, simply hit the MENU 
button while on the Tracks Page, select Delete All Saved and 
press ENTER. 
 


 
 
Deleting Tracks Saved on Micro SD Card 
 


1. From the Tracks Page, scroll to the Setup button using the ROCKER key and 
press ENTER.  Scroll down to the Data Card Setup button and Press ENTER.  
Next, scroll to the Delete All button and press ENTER.   


 


 
 
 
NOTE: You can also select an individual track to delete, rather than all tracks at 
once.  Simply scroll down and highlighting the track you want to delete, press 
ENTER, select Yes and press ENTER again. 
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